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The following provides a workflow of each main functional area in Blackbaud Direct Marketing, and how these
pieces work together in the overall workflow of the program.
Using the features in the program, you can plan and execute all facets of your direct and public marketing efforts.
• Administrators can establish the record source(s) that the program will work with, the users and their roles in
the program, and more.
• Use the Vendors, Creatives, and Packages features to establish records for the businesses you purchase items
from, the items you use in your direct and public marketing efforts (anything from graphics to small gifts such
as pens you may include), and the actual pieces that make up your marketing efforts.
• Add acquisition lists to the program. These hold general information about the list and group related list
segments that make up the list. Use list segments to import the data in the list into the program for use in your
marketing efforts.
• Use finder files to keep rented and exchanged names and addresses separate from your house file. The records
included in these files cannot be stored permanently in the database until those recipients give a gift.
• Use the Segmentation feature area to create the segments that will enable you to target specific direct
marketing efforts and pieces of mail to different groups of donors.
• Use the Public Media feature area to create public media segments such as media outlets, time slots, and
marketing locations to target your public marketing efforts.
• The Planner feature enables a Marketing Executive or Director to plan out the fiscal year (or other fixed time
period) for your organization. This person in your organization knows the strategy and budget and captures
this information in the Planner.
• Create source code parts and layouts that you can apply to your marketing efforts to establish the specific
combination of list, package, segment, etc. that results in a particular gift.
• Use the Marketing Efforts feature to create the direct or public marketing effort itself, including the
segmentation or public media. You can then create an export for the marketing effort to send to a mailing
house or call center, for example, or import into another program.
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• Perform analysis by running performance reports on all facets of your marketing efforts.

Marketing Plan Workflow
To create a marketing plan, first you need a plan template. A template enables you to build a hierarchy of items
such as campaigns or programs (you determine the name of these items) and color code them for easy
recognition of your plans. The bottom two levels of a template are always “Planned appeals” and “Planned
marketing efforts.” Then you can create a plan based on the template and add the items specified in the
template hierarchy.
You also include “assumptions” for projected budget and revenue for the items, as well as segment summaries
and specifications to describe who should be included in the various segments of a planned marketing effort.
Once all stakeholders have signed off on a plan, you can approve it. When you approve a plan, a marketing effort
is created for each Planned marketing effort in the plan. The Segments grid in each marketing effort is
automatically populated with all the Segment Summaries from the plan. These summaries enable you to group
segments together so their values “roll up” into each other.

List Workflow
Before you bring a list into the program, you should configure the criteria you want to use to determine whether
a record on the list is already present in your source system. This is set in Configuration, Record Sources, in the
source you intend to use as a target for a list. Based on this criteria, a query is automatically generated that
includes all members of the list who are duplicates in your database.
Then add the list which acts as a list header that holds general information about the list. It serves as a way to
group related list segments that make up the list. For example, a list can group all imported and vendor managed
segments used for the same marketing effort. You can have a list called Reader’s Digest and its list segments are
Readers Digest 0-12 month subscribers and Readers Digest 13-24 month subscribers.
Use list segments to import and manage list records. You can specify information about the list and the rules for
using it. When you add an imported list, you must first determine how the fields in the import file will map to
your record source. If you are importing your first list, you must create a file layout to determine how the fields in
the list will map to those in your record source.
When creating a file layout, the program will automatically map as many fields as possible and you can manually
map any the program is unable to match. Once you save a file layout, you can use it when you import other lists
into the same record source. For example, different lists from the same vendor may use the same layout.
Bring the records into the program based on your file layout mappings. Once the list is brought in, it can be
added to the Consolidated Query View which enables you to create queries that pull in all records meeting the
criteria, whether the records came from your source or a list. You can now use the list segments for marketing
efforts.
Finally, you can reuse lists or purge or delete them. For example, if you use the same list for subsequent
marketing efforts, you can add new list segments for each new marketing effort or create one list segment for
which you change the import file each year. When the imported records for a list segment are no longer valid or
your organization no longer has permission to use those records, you can purge the list segment’s import
history from the system. To completely remove any trace of the imported records (including all information and
IDs), you can delete the list segment’s import history.
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Segment Workflow
The main reason to use segmentation is that different groups of donors will have different responses to
marketing efforts. Targeting specific groups enables you to increase the effectiveness of your efforts. After you
create the marketing effort, you then add direct marketing segments to target specific sets of users with certain
packages or public media segments to target a demographic of people such as those who travel by a specific
location, visitors of a specific website or business, or the audience of a specific television or radio program. You
can specify different packages (marketing pieces such as mail or email) and apply them to particular segments.
You can create individual segments or create multiple segments at the same time. After you create segments,
you can apply them to your marketing efforts. There are several types of segments, each serving a different
purpose. When you create multiple segments, the segment builder enables you to create numerous segments
from a limited number of selections. You can also group segments so that you can apply all segments in a group
to a marketing effort at the same time instead of applying them individually.
Selections form the backbone of your direct marketing segments. When creating constituent, revenue, or
membership segments, you specify one or more selections to be used to filter your source records and
determine which ones belong in the segment. You can create the selections you will need before you begin
adding segments, or create the selections while you are adding segments.
Constituent segments are based on one or more selections of constituents. You can add list segments for use
with imported and vendor managed lists. These segments help you track the costs and record counts for
imported and vendor managed lists used on marketing efforts. Revenue segments group donors for
acknowledgement efforts, while membership segments group constituents for membership efforts.
Use public media segments to target prospects you do not know with customized content based on their
characteristics. For example, you can base public media marketing efforts on media outlets and time slots, such
as for broadcast or online efforts, or marketing locations, such as for billboards, promotional literature, or other
out-of-home efforts. Through these segments, you can communicate your message to a specific demographic,
such as prospects who live in a specific area, visit a specific website, or prefer a specific television or radio
program.

Source Code Workflow
You first create a source code parts and layouts that contains the items and formatting instructions for a valid
code. You can then apply that layout to the marketing efforts and other items such as lists, segments, and
packages that you want to contain a code. When you export the marketing effort to a fulfillment house, you
specify the codes that should be included on the various response devices included in the marketing effort.
When gifts come in from the marketing effort, the appropriate code is entered on each gift record so you can
establish the specific combination of list, package, segment, etc. that resulted in the gift for analysis purposes.
For example, a typical source code could be made up of three pieces or codes; one that defines the marketing
effort, one that defines the segment within the marketing effort, and one that defines the list used by the
marketing effort. You could build a layout to format this source code as follows:
07A051 - could be the Marketing Effort code with two digits representing the year, “A” for Acquisition, two digits
for the month, and a single digit for a month sequence (in case you have two marketing efforts in May).
134 - could represent the segment, in this case a three digit Recency, Frequency, and Monetary (RFM) score.
L001 - could represent the List ID.
The combined Source Code in this case would be 07A051 134 L001.
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Marketing Effort Workflow
Setting up direct and public marketing efforts requires several steps. In Configuration, an administrator must
determine the record sources to include in a marketing effort. When setting up a record source, the Gift Record
Source is required to activate a marketing effort. When an administrator selects a gift record source and maps
the appropriate fields, an activated marketing effort can determine all the gifts associated with a marketing effort
and calculate performance measures based on the gift amounts and other criteria.
Also, Export definitions enable you to specify several different templates that you can use when exporting an
active marketing effort.
After an administrator has prepared your data record source, in the Marketing Efforts feature area, you can
create a marketing effort based on an approved marketing plan, which enables information from the plan to
default into the marketing effort, or you can create a “one-off” marketing effort. When you create the marketing
effort, you can specify records that should be included or excluded from it, or you can do this later.
After you create the marketing effort, you then add direct marketing segments to target specific sets of users
with certain packages or public media segments to target a demographic of people such as those who travel by a
specific location, visitors of a specific website or business, or the audience of a specific television or radio
program.
For the marketing effort and its various components, you can specify source codes. These source codes will be
included on the response devices used in the marketing effort, and entered on gift records that come in from the
marketing effort. By recording the code on a gift record, you establish the specific combination of list, package,
segment, etc. that resulted in the gift for analysis purposes.
You can then test various aspects of a marketing effort, such as different combinations of packages and
segments, on a subset of recipients before you send out the actual marketing effort.
When you finish creating and testing a direct marketing effort, you can activate it. By activating the marketing
effort, you are specifying the appeal to be associated with gifts that come in as a result of the marketing effort.
Public media marketing efforts are activated automatically when you create the effort. During the creation
process, you also select the appeal to associate with the effort.
Finally, you can create an export file of the marketing effort for use by a processing house or to import into
another program.
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The program provides many features to help you navigate through, access, and share your information. This
guide explains various navigation tools in the program and how to use features such as the home page and
favorites.
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Application-Level Search
The application-level search function helps you find a specific feature in the program when you do not know its
location. The Find field available at the top of any application page accesses a pervasive search engine. Based on
the search option you select, the engine searches the program and returns links to all pages, tasks, RSS feeds,
and help documentation that satisfy the search criteria. The search engine also overlooks minor spelling errors
and respects system security.
You can base your search on features, RSS feeds, or a quick find option.

Configure Search
Although the pervasive search function includes some items by default — ad-hoc and smart queries, constituent,
mailing, revenue, to name a few — you can edit the search list and expand this number.

Edit Search Lists
When a feature search returns a feature that requires context, the search page must be able to resolve the
context. Context on a feature is always tied to a specific record type, as are search lists; however, each record
type can have multiple search lists associated with it. For these records types, you must manually map to the
search list to use. For example, the batch record type includes three search lists: batch template search, batch
search, and batch type search. With the Default search list configuration option in Administration, you can
select the list to use in your searches.
} Select search lists for record types
1. From Administration, click Default search lists under Configuration. The Default Search Lists page
appears. This page displays a list of record types mapped to related search lists.

2. Click Edit. The Define the default search list for system record types screen appears.
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3. Under Default search list, select the list to use for the corresponding record type.
4. Click Save. You return to the Default Search Lists page. Your chances appear in the grid.

Feature Search
A feature search is a quick navigational tool that searches all areas of the program — pages, tasks, RSS feeds —
for information that satisfies your search criteria. It is the most general of the search options and likely generates
the most results.
For example, if you enter “add constituent” in the Find field, the Search Results page displays links to areas in the
program that match the words “add” and “constituent.” On the Search Results page, if you click a task link such
as Add an individual, the task is invoked, and the Add an individual screen appears for you to enter a new
constituent. If you click a page link such as Constituent Giving Information, a search screen appears, and you
can search for the constituent whose information you want to view.
To execute a feature-level search, click Features beside the Search button and select the feature to search. Enter
your search criteria in the Find field and click Search. The results appear on the Search Results page.

Context-Based Feature Search
In the Find field, you can include context information and refine your feature search. For example, to locate
Robert Hernandez’s constituent record, rather than search for just “constituent record,” you can include the
constituent name: “constituent info?rob hernandez.” In the search results, you can click links to various
constituent areas in the program with information about Robert Hernandez. When you click a link, constituent
information appears or a search screen appears with a list of matching records.
In the Find field, you can also call up and display ad-hoc and smart query results. For example, if you have an
“Ohio Constituents” ad-hoc query, you can enter “query?Ohio Constituents” in the Find field. When you click
Ad-hoc Query Results in the search results, the Ad-hoc Query page appears for the “Ohio Constituents” query.
From this page, you can browse records, edit the query definition, create an export, create tasks, and assign
permissions.
Note: For information about Query, see the Query chapter in the Query and Export Guide.
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RSS Feed Search
RSS feeds in the program are included by default in feature-level searches. However, you can search for RSS feeds
only. This limits the number of results and provides a way to view RSS feeds available.
To restrict your search to RSS feeds, click Features beside the Search button and select RSS feeds. Enter your
search criteria in the Find field and click Search. Only RSS feeds that match your search criteria appear on the
Search Results page.

Click an RSS feed to access the feed page in the program. From this page, you can review feed data and subscribe
to the feed.

Quick Find Search
With the quick find functionality, you can search for and open specific records in the application.
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For example, if you click Features beside the Search button and select Constituents, Constituent, you can enter
“Joseph Bernstein” in the Find field to search for Joseph’s constituent record. If a single record matches your
criteria, the record opens. If multiple records match your search criteria, a search screen appears with a list of
matching records. You can refine your search criteria and execute a new constituent search.

Search Help Documents
The feature-level search functionality includes help topics in the search process. The top five help topics related
to the search criteria appear on the Search Results page. Under Help Contents, links to related help topics
appear. To access the help file, click a link.

General Navigation
The program includes a variety of navigation features that give you increased control over the software.

Menu, Navigation, Explorer, and Status Bars
Pages in the program include the following features:
• Navigation bar: The navigation bar allows you to navigate through the program, return to your home page,
and move forward and backward through pages in your history. Your role in the program determines the
appearance of the navigation bar, and it only displays features that you have permission to access.
• Explorer bar: From the explorer bar, you can quickly access recently performed searches, recently viewed
records and pages, and shortcuts. Depending on the current page, you can also access related tasks and
activities.

9
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Home Page
The Home page appears when you start the program. To return to it, click Home on the navigation bar. You can
designate another page in the program as your Home page. This can be useful if you work primarily in one area of
the program or want a certain page to appear each time you start the program. If you use the default Home page
and have the necessary security rights, you can customize its appearance.

Customize the Default Home Page
If you use the default home page and have the necessary security rights, you can add and remove tasks from the
page.
} Customize the home page
1. From the Home page, click Customize. The Customize home page screen appears.
2. Under Functional area, select an item. The tasks for that section of the program appear under Task.
3. UnderTask, select the tasks to include on the home page.
4. SelectDisplay favorites to display your favorites on the home page.
Note: To revert to the default home page configuration, select Use default layout.
5. Click Save. Your selections appear on the home page.
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Calendars
Various calendars are used throughout the program to provide a view of scheduled items related to your
organization or community. These can include upcoming events, mailings, holidays, or other items related to the
specific calendar you are viewing. In addition to an effective view of scheduled items, many calendars provide
tools to add and edit items directly from the calendar, which can save you time.
Although the calendars displayed throughout the program may have different purposes, they each have several
common components to help you more effectively view and interact with information. For example, filters
provide a way to narrow or expand the items displayed on the calendar and color-coding helps you identify
items.
To help customize calendars for how you work, you can change the colors used to identify specific items on the
calendar. To change the colors defined for each item that appears on the calendar, click Customize style. In the
grid, within the Style column, click the down arrow and select a color to assign to each. Click OK to save.

Workspace for Your System Role
Depending on your role, you can access a workspace from your home page to view and manage tasks associated
with your role and key performance indicators (KPIs) to track the effectiveness of your efforts. You can also
access the organization calendar to view activities scheduled at your organization. By default, you can access the
workspace from your home page. On the default home page, click Workspace. The Workspace page appears and
displays information pertinent to your role.
If your organization enables email alerts, you can configure and manage your email preferences from the
Workspace page. For example, you can enter the email address to receive alerts or select whether to receive
specific alerts. Under Tasks, click Email preferences. Your application user record appears. For information about
how to configure email preferences, see the Administration Guide.
Depending on your role and the activities you perform, the workspace may contain multiple tabs to help you
navigate through the information.
Note: For information about how to add and manage items or set filters on the Organization Calendar, see the
Administration Guide.
Organization Calendar
On the Organization Calendar tab, you can view scheduled items related to your organization or community,
such as to help schedule and coordinate activities and processes. From the calendar, you can add and manage
calendar items such as holidays, community events, or scheduled breaks in your organization’s operation. You
can also select the type of activities to view during a specific period of time.
Note: Depending on your role, you can manage your batches from the Workspace page. To access the Batch
Entry page, such as to manage additional batches, click Batches under Administration. For information about
batch entry, see the Data Management Guide.
My Tasks
On the My Tasks tab, you can view and manage tasks related to your system role. For example, if you work with
mailings or interact with constituents, your mailings and constituent interactions appear under My tasks. If you
work with batch entry, batches assigned to you such as for data entry or approval appear. You can select
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whether to display only a specific type of task and whether to display completed tasks. To filter the grid, select
the criteria of the tasks to view and click Apply. To remove the filter, click Reset. To update the information in the
grid, click Refresh List. From the grid, you can add and manage your tasks as necessary. To view additional
information about an item related to a task, such as a batch or an interaction, select it in the grid and click Go to.
The record of the item appears.
Donors
If your role works with revenue transactions, the Donors tab appears. Under Donors, you can view the
constituents associated with recent pledges and payments toward donations or recurring gifts. You can select
the recent time period of the transactions to view, such as Today or This month. You can also select to view only
transactions above a specific revenue amount within the selected time period. To filter the grid, select the criteria
of the transactions to view and click Apply. To remove the filter, click Reset. To update the information in the
grid, click Refresh List. To view additional information about a donor, select the donor in the grid and click Go to
constituent. The record of the constituent appears.
Note: Depending on your role, you can view your KPIs from the Workspace page. To access the KPI Instances
page, such as to add or manage KPIs, click KPIs under Administration. For information about KPIs, see the
Data Management Guide.
Note: Depending on your role, you can view your KPIs from the Workspace page. To access the KPI Instances
page, such as to add or manage KPIs, click KPIs under Administration. For information about Batch entry, see
the Data section of the help file.
KPIs
On the KPIs tab, you can view key performance indicators (KPIs) to track the effectiveness of activities pertinent
to your role. KPIs track your strategic performance to help determine a course of action. When you monitor your
business activity with KPIs, you can place a value on otherwise difficult to measure activities such as leadership
development. To view the value of a KPI, select it under KPIs and click Show Details. The Details window displays
the value of the selected KPI. To update the value of a KPI, such as to include recent activity, select it in the grid
and click Update KPI value. To view additional information about a KPI, select it in the grid and click Go to KPI.
The record of the KPI appears.
Note: Depending on your role, you can view your smart queries from the Workspace page. To access the Query
page, such as to add or manage smart queries, click Smart queries under Administration. For information
about query, see the Data Management Guide.
Smart Queries
On the Smart Queries tab, you can view smart queries to access records based on criteria pertinent to your role.
Smart queries are designed to allow you to easily create a query that is not ad-hoc but groups records based on
specific criteria such as SYBUNT (constituents who gave Some Year But Unfortunately Not This year). You can use
smart queries for the same purposes as ad-hoc queries, such as to casually browse records or generate a
selection for use in other processes. To view the results of a smart query, select it under Smart queries and click
View results. The record of the smart query appears.
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Change Password
All users should change their passwords the first time they log into the application and on a regular basis
according to your organization’s security policy. Passwords expire every 90 days and users are prompted 15 days
in advance to change it.
Note: If your organization does not host the program through Blackbaud and does not use organizational
units, please contact your system administrator for information about how to change your password.
All passwords are case sensitive and must meet the following complexity standards:
• A password cannot be the same or overly similar to a previously used password.
• Passwords must be at least eight characters in length.
• Passwords must contain at least three of the following four character types: uppercase letters (ABC), lowercase
letters (abc), numbers (123), or symbol characters (!@#).
} Change your password
1. On the menu bar, click Welcome and select Change password. The Change password screen appears.
2. In the Old password field, enter your current password.
3. In the New password and Confirm password fields, enter a new password that meets the following
complexity requirements:
• A password cannot be the same or overly similar to a previously used password.
• Passwords must be at least eight characters in length.
• Passwords must contain at least three of the following four character types: uppercase letters (ABC),
lowercase letters (abc), numbers (123), or symbol characters (!@#).
4. Click Save.

Refresh a Page
When you work in the program, you might encounter a situation where a record is changed by another user
while you view it. If this happens, the information on the page might be inaccurate. You can refresh the page to
display the most current information in the database.
To refresh a page, click Refresh under Tasks.

Filters
The Filter button allows you to customize entries in data lists. You can use the Filter button to select record
types to display in a list or to select a date range. The filter options that appear depend on the type of data in the
list.
For some data lists, the filter options always appear above the lists. For other data lists, you must click Filter to
open the filter options.
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The filter options that appear depend on the data list.

When you apply filters to a list of items, the program remembers your filter settings and uses them as defaults
the next time you view the list. For example, if you typically are only interested in the most recent transactions
on a constituent’s revenue history, you can apply a date range filter of “Last 30 days.” When you go to any
constituent record and view the revenue history, it uses the default filter and displays only transactions that took
place in the last 30 days. If you apply a date range filter of “Last quarter,” the next time you view the revenue
history, it displays transactions from the last quarter.
Filter settings are stored for each user, so a user’s defaults do not impact anyone else. Filter settings are also
stored across sessions, so you can log out and log back in and still see your defaults.
Note: There are also filters on some dashboards and reports; however, these settings are not stored and must
be reapplied each time you access the dashboard or report.
You can also sort the information that appears in a datalist by clicking on a column heading. For example, you
can click on a Date column heading and items will be listed in chronological order. Sort options are not stored
and must be reapplied each time you access the datalist.

Really Simple Syndication (RSS)
You can use the program to publish lists of data, such as registrations for an event, as Really Simple Syndication
(RSS) feeds. RSS is a simple XML-based system that lets users subscribe to content such as news or website
updates and then aggregate it into a single location using RSS-aware software. With this feature you can target
important information to members of your organization. Users who subscribe to the RSS feed can view the
information as it is updated in the program. For example, an RSS feed can supply the person responsible for a
special event with up-to-date registration information.
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} Use the RSS feature
1. Locate a data list that has been RSS-enabled in the program. The View RSS feed icon denotes a data list
that can be subscribed to as a feed.

2. Click View RSS feed. A link to the feed opens in your default web browser.

Note: The link to the RSS feed is in the form of a text-based URL. For example, https://<SERVER
NAME>/<SERVER PATH>/<RSS FEED LINK>.
3. If the web browser supports RSS, it can give you the option to subscribe to the feed.

4. You can use the browser’s built-in functionality to subscribe to the feed, or you can copy and paste the
link to the RSS feed into a preferred software or service. The method used to view the feed determines
how it looks.
5. The link to the RSS feed can also be shared with other users. You can send the URL, and they can view the
feed with an RSS-enabled software or service. As the information is updated in the program, the
information in the related RSS feed is visible to all subscribers.
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Mark Data as Inactive
When you delete information from the database, you cannot recover that data. As an alternative, you can mark
data such as constituent records or membership program levels as inactive. This allows you to retain the
information in the database but exclude it by default from lists, search results, queries, and reports.
To mark data as inactive, you select it in the grid and either click Mark inactive in the action bar or under Tasks in
the explorer bar. You can use filter options in the program to include inactive data in lists, search results, queries,
and reports.

To restore inactive data, you select it in the grid and either click Mark active in the action bar or under Tasks in
the explorer bar.

Zoom Buttons
When the program displays data in summary views, sometimes the data does not fit in the space provided and
must be truncated. When this happens, a zoom button appears beside the data, and users can click the button
to view the complete data.

When users click the zoom button, a screen appears with the complete data.
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Elsewhere in the program, a similar zoom button appears in some fields in the program where users can add and
edit data.

When users click this zoom button, an expanded field appears, and they can edit or view data that does not fit in
the space provided by the field.

Navigation Tree
The navigation tree is an efficient way to view multiple, nested pages of information. The navigation tree displays
information as an expandable, hierarchical set of links to other pages. This lets you to see the big picture rather
than a single path.
For example, you can open a fundraising purpose and get a broad view of all the activities involved by displaying
links to all of the associated appeals.
If a navigation tree is available, it is collapsed on the top-right side of the page. To expand the navigation tree,
move your cursor over the button. You can resize the panel or pin it to keep it visible when you move the cursor
away. You can also toggle the visibility of the navigation tree by selecting View, Navigation tree in the menu.
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} Access the navigation tree
1. Navigate to a page with a navigation tree. The navigation tree is collapsed on the top-right side of the
page.

2. Move the cursor over the button. The navigation tree appears.
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• To hide the navigation tree, move the cursor away.
• To keep the navigation tree visible, click the button or click Auto Hide on the navigation tree.
• To close the navigation tree, click Auto Hide again and move the cursor away.
• To close the navigation tree completely, click Close on the navigation tree. The navigation tree and
button no longer appear on the page.
• To restore the navigation tree and button, select View, Navigation Tree in the menu.
3. When the navigation tree is open, you can view information about connected pages.
• To expand and collapse the nested groups, click the plus and minus icons beside the page.
• To access a page, place your cursor over the page name and click the link.

Export Grid
When you right-click a data list, you can select Export grid to export the contents of the data list to a .csv file. The
.csv file includes the data from each column in the data list.
Note: If you use Multicurrency, amounts associated with exported data display in the user’s base currency.
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KPI Dashboard
All users have a personal dashboard, displaying key performance indicator (KPI) data. The dashboard includes
data from every KPI instance that the user has permissions to.
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The KPI dashboard stores all KPI values and statistics in an easy to view format. In addition, you can customize
the dashboard view to make it easier to access the information you need. You can also export the information to
Microsoft Excel or generate a PDF.
For more information about the KPI dashboard, see the Reports and Analysis Guide.

Documentation
On the Documentation tab, you can add notes to track helpful or interesting information about your records.
You can save links to websites or related materials stored outside of the program. You can also attach items
directly to records. When you attach a file, the program stores a copy in the database.

Attachments
You can attach items to records. When you attach a file, the program stores a copy in the database.
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Add Attachments
You can use attachments to track additional details about records. When you attach a file, the program stores a
copy in the database.
} Add an attachment
1. On the Documentation tab of a record, click Add, Attachment. The Add an attachment screen appears.
2. Select an attachment type. Enter the date, title, and author. To search for the attachment, click Choose
file.
3. Click Save. You return to the Documentation tab.

Add an Attachment Screen
Screen Item

Description

Type

Select the type of attachment. The system administrator configures attachment types. If
you have security rights, click Type to add an attachment type.
Enter the date of the attachment.
Enter the title, or purpose, of the attachment.
To search for the author, click the binoculars. A search screen appears.
To locate the attachment, click Choose file. To view an attachment, click Open file. To
remove an attachment, click Clear file.

Date
Title
Author
File

Edit Attachments
On the Documentation tab, you can edit an attachment. You can remove a file and choose a different file. You
can also view an attachment.
} Edit an attachment
1. On the Documentation tab of a record, select an attachment and click Edit. The Edit attachment screen
appears.
2. Make changes as necessary to the attachment type, date, title, or author. To view an attachment, click
Open file To remove an attachment, click Clear file To select a different file, click Choose file.
3. Click Save. You return to the Documentation tab.

Delete Attachments
After you add an attachment to the Documentation tab, you can delete it as necessary.
} Delete an attachment
1. On the Documentation tab of a record, select an attachment and click Delete. A confirmation message
appears.
2. Click Yes. You return to the Documentation tab, and the attachment no longer appears.

Media Links
On the Documentation tab, you can save links to websites or related materials stored outside of the program.
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Add Media Links
When you add a media link, you enter the website address.
} Add a media link
1. On the Documentation tab of a record, click Add, Media link. The Add a media link screen appears.
2. Select a media link type. Enter the date, title, and author. Enter the URL for a website.
3. Click Save. You return to the Documentation tab.

Add a Media Link Screen
Screen Item

Description

Type

Select the type of media link. The system administrator configures media link types. If
you have security rights, click Type to add a media link type.
Enter the date of the media link.
Enter the title, or purpose, of the link.
To search for an author, click the binoculars. A search screen appears.
Enter the URL for a website.

Date
Title
Author
Media URL

Edit Media Links
You can edit the URL for a website.
} Edit a media link
1. On the Documentation tab of a record, select a media link and click Edit. The Edit media link screen
appears.
2. Make changes as necessary to the media link type, date, title, or author. You can edit the URL for a
website.
3. Click Save. You return to the Documentation tab.

Delete Media Links
After you add media links to the Documentation tab, you can delete them as necessary.
} Delete a media link
1. On the Documentation tab of a record, select a media link and click Delete. A confirmation message
appears.
2. Click Yes. You return to the Documentation tab, and the media link no longer appears.

Notes
On the Documentation tab, you can add notes to track helpful or interesting information about your records.

Add Notes
On the Documentation tab, you can track notes about your records.
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} Add a note
1. On the Documentation tab of a record, click Add, Note. The Add a note screen appears.
2. Select a note type. Enter the date, title, author, and the content of the note.
3. Click Save. You return to the Documentation tab.

Add a Note Screen
Screen Item

Description

Type

Select the type of note. The system administrator configures note types. If you have
security rights, click Type to add a note type.
Enter the date of the note.
Enter the title, or purpose, of the note.
To search for an author, click the magnifying glass. A search screen appears.
Enter the content of the note.

Date
Title
Author
Notes

Edit Notes
On the Documentation tab, you can edit notes as necessary.
} Edit a note
1. On the Documentation tab of a record, select a note and click Edit. The Edit note screen appears.
2. Make changes as necessary to the note type, date, title, author, or note content.
3. Click Save. You return to the Documentation tab.

Delete Notes
After you add notes to the Documentation tab, you can delete notes when necessary.
} Delete a note
1. On the Documentation tab of a record, select a note and click Delete. A confirmation message appears.
2. Click Yes. You return to the Documentation tab, and the note no longer appears.

Notifications
Notifications allow you to share important information about a record or a group of records with users. You can
determine whether all users should receive a notification or only a targeted group of users. For example, you
may want all users to receive a notification when they open the record of a board member.
Notifications are not available for every record type. They are available only for:
• Bank Account Adjustment records
• Bank Account Deposit records
• Bank Account Deposit Correction records
• Constituent records
• Event records
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• Membership records
• Planned Gift records
• Research Group records
• Revenue records
Notifications appear on the information bar of a record.

Note: Notifications for constituents also appear in the Constituent Window of a revenue batch.
You can also set notifications to appear on a separate screen when a record is accessed. The notification screen
appears the first time a record is accessed during a session. If you leave the record and return within 60 minutes,
the notification screen does not appear again. However, if you return after more than 60 minutes, the
notification screen appears again.

You can create notifications for groups of records in Administration. You can also create notifications for a
specific record from the Documentation tab of the record.

Add Notifications to Specific Records
On the Documentation tab, you can add a notification to a note on a record. First, you select or create a note
with the notification’s message. Then you add the notification to the note.
} Add a notification
1. On the Documentation tab, select a note to use for the notification. The note’s title and text appear as
the notification.
Note: You must add a note to the record before you can add a notification.
2. Click Notification, Add. The Add notification screen appears.
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3. Select how long to display the notification, whether to display it on a separate screen, and the users who
view the notification.
4. Click Save. You return to the Documentation tab.

Edit Notifications for Specific Records
After you add a notification to a record, you can edit its properties on the Documentation tab. You can change
how long to display the notification and who views it. To edit the notification’s content, you edit the note
associated with the notification.
} Edit a notification
1. On the Documentation tab, select the note with the notification and click Notification, Edit. The Edit
notification screen appears.
2. Make changes as necessary to the notification, such as how long to display it and who views it.
Note: To edit the notification title or content, edit the note itself.
3. Click Save. You return to the Documentation tab.

Delete Notifications from Specific Records
On the Documentation tab, you can delete a notification when you no longer need it. To remove a notification
from a record, select the note with the notification to remove and click Notification, Delete.

Open Attachment Files
After you add an attachment on the Documentation tab, you can open the attachment. Select the attachment
and click Open file.

Report Toolbar
Several features in the program offer reports to view data. When you generate a report, you can use the report
toolbar to modify how you view the report. The toolbar buttons are common to all reports.
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HTML Editor
The program provides a powerful HTML editor to allow you to format and lay out content. With the HTML editor,
you can update content easily and safely while you maintain control over the design and content.
You can use the HTML editor in different views, depending on your HTML experience and where you access the
HTML editor in the program.
• Normal – When you open the HTML editor to create or edit content, this is the “normal” view. This view is
similar to a standard word processing application. By default in normal view, when you press ENTER, you create
a <p> tag in the HTML content to indicate a new paragraph. When you press SHIFT + ENTER, you create a <br>
tag to indicate a single carriage return in the content.
• HTML – To view or edit the HTML source code, click HTML Code on the View tab in the toolbar. The HTML
Source Editor screen appears. To return to the normal view, close the window. You cannot use the HTML view
to embed your own form via HTML in the HTML editor. We recommend you put the form on a page that is not
stored in the program but can be referenced in an iFrame. For more information about how to include
customized forms in the program, contact Blackbaud’s Professional Services at solutions@blackbaud.com.
• Preview – To view the content as it will appear on the web page and to test hyperlinks, click Preview on the
View tab in the toolbar. The Preview screen appears. To return to the normal view, close the window.

HTML Editor Functions
These tables explain the buttons and menus on the toolbar of the HTML editor. Some features have more
buttons available than others.
Note: On your website, users can use an HTML editor with a limited set of these buttons on some parts. With
the HTML editor, users can also insert images, tables, or links.

Buttons on the Toolbar
Button Function
Full screen
Preview
Print
Edit HTML
source
Clean up
HTML

Spell check

Description
To work in full screen mode, click Full screen. To turn off full screen mode and view the
screen at its normal size, click Full screen again.
To view the content as it will appear on the web page, click Preview. The Preview screen
appears. To return to the normal view, close the window.
To print the current content, click Print. The Print screen appears. Select the printer and
your print preferences, and click Print.
To view or edit the HTML source code, click Edit HTML source. The HTML Source Editor
screen appears. To return to the normal view, close the window.
To remove unnecessary tags from the HTML, click Clean up HTML. The Clean Up HTML
screen appears. With the buttons on this screen, you can remove all HTML tags,
remove all Microsoft Word-specific markup, clean up stylesheets, clean up <Font> tags,
and clean up <Span> tags.
To check the spelling, click Spell check. When you turn the spell checker on, it checks
the spelling of all existing content in the HTML editor and will check new content as you
create it. When the spell checker finds an error, a red squiggly line appears below the
word. Right-click the underlined word to select the correct spelling. You can also spell
check in different languages. Use the drop-down to the select the language.
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Button Function

Description

To find and replace text, click Find and replace. The Find/Replace screen appears. In the
Find what field, enter the text to search for. In the Replace with field, enter
replacement text. To search for the text, click Find next. To replace the text, click
Replace. To replace all instances, click Replace all.
To remove text from the content area and copy it to the clipboard, click Cut. The text is
Cut
removed, and you can paste it elsewhere in the content area.
To copy text to the clipboard, click Copy. You can paste the text elsewhere in the
content area.
Copy
Note: For Firefox, security settings disable the Copy button. To copy text to the
clipboard in Firefox, highlight it and press CTRL-C.
To paste text from the clipboard, click Paste. The text appears in the content area. It
retains the formatting from when you cut or copied it.
Paste
Note: For Firefox, the Paste button in HTML mode removes HTML tags. To paste text
with HTML tags in Firefox, press CTRL-V. For Firefox on Macs, you cannot paste text with
HTML tags in HTML mode because Ctrl-V also removes the HTML tags.
Paste plain
To paste text from the clipboard without any formatting, click Paste plain text. The text
text
appears in the content area and does not retain its formatting.
To paste text from the clipboard that you copied from Microsoft Word, click Paste from
Paste from
Word. The text appears in the content area without the proprietary HTML of Word. The
Word
text format may differ from the format in Word.
Insert page
To insert a printed page break, click Insert page break. The HTML editor adds a division
break
with an attribute of PAGE-BREAK-BEFORE: always at the selected location.
Insert
To insert a horizontal line, click Insert horizontal rule in the toolbar. On the screen that
horizontal
appears, enter the width and height for the line and select whether to include a
rule
shadow.
insert a special character, click Insert custom characters. The Custom characters
Insert custom To
screen
appears. In the grid, select a character. The custom character appears at the
characters
selected location.
To link to a specific location on a page, place your cursor at the link’s endpoint (for
example, a heading) and click Insert anchor. The Insert/edit anchor screen appears so
you can enter a name for the anchor’s location. The HTML editor adds <a
Insert anchor name="anchor name"></a> before the defined location. In the normal view, the HTML
editor displays an anchor symbol at the defined location.
To link to the anchored location, in the HTML source view, append “#anchorname” to
the end of the link.
insert an image, click Insert image. On the Select Image from Image library screen,
Insert image To
you can select the image.
To link text to a web address or web page, click Insert link. If the text is in a format that
Insert link
the program recognizes as a web address or page, such as www.abc123.org, the link
formats automatically. Otherwise, the page link screen appears.
remove a hyperlink from text, click Remove link. The text no longer acts as a
Remove link To
hyperlink.
To undo the last action in the content area, click Undo. The action is reversed. You can
Undo
undo multiple actions.
To redo an undone action in the content area, click Redo. The action is reinstated. You
Redo
can redo multiple actions.
Find and
replace

Help

To access a description of the HTML editor features, click Help. The help file appears.

Insert table

To insert a table, click Insert table. The Insert/edit table screen appears. For more
information about option on this screen, see HTML Editor Table and Line Properties on
page 34. After you create a table, you can select it and click Insert table to edit its
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Description
properties.

Delete table

To delete a table, select it and click Delete table.

Row
properties

To edit the properties of a row, select it and click Row properties. The row properties
screen appears. For more information about row properties, see HTML Editor Table
and Line Properties on page 34.
To edit the properties of a cell, select it and click Cell properties. The cell properties
screen appears. For more information about cell properties, see HTML Editor Table and
Line Properties on page 34.

Cell
properties
Insert row
above
Insert row
below

To insert a row above a row in a table, click Insert row above. A new row appears.

Delete row

To remove a row from a table, click Delete row. The row is deleted.

Insert
column to
the left
Insert
column to
the right
Delete
column
Split merged
table cells
Merge table
cells
Show table
borders

To insert a column to the left of a column in a table, click Insert column to the left. A
new column appears.

To insert a row below a row in a table, click Insert row below. A new row appears.

To insert a column to the right of a column in a table, click Insert column to the right. A
new column appears.
To remove a column from a table, click Delete column. The column is deleted.
To split a cell that spans multiple rows into two cells, click Split merged table cells. The
selected cell no longer spans the row on the bottom.
To merge a cell with the cell to its right, click Merge table cells. Any content in the cell
on the right is removed, and the selected cell now spans both columns.
To hide or reveal the borders of your tables, click Show table borders.

To insert a layer, click Insert new layer. The HTML editor adds a layer using the <div>
tag. To reposition the layer, select the layer and use the crossed arrows to drag the
layer to the new location. To resize the layer, drag the resize handles found at the
layer’s corners or sides.
Move layer
To move a layer forward, select the layer and click Move layer forward. The HTML
forward
editor increases the z-index number for the layer.
Move layer
To move a layer backward, select the layer and click Move layer backward. The HTML
backward
editor decreases the z-index number for the layer.
To apply absolute positioning to a selected layer, click Absolute positioning. The HTML
Absolute
editor adds the position: absolute tag to the layer and its location on the page in pixels.
positioning To remove absolute positioning from the selected layer, click Absolute positioning
again.
Direction left To apply left to right directionality to all items in the division, click Direction left to
to right
right. For a left to right table, column zero is on the left side and row zero is at the top.
Direction
To apply right to left directionality to all items in the division, click Direction right to
right to left left. For a right to left table, column zero is on the right side and row zero is at the top.
insert a long quotation, click Block quote. The HTML editor adds a <blockquote> tag
Block quote To
around the selected text.
To add a tooltip that defines an abbreviation, select the word and click Abbreviation.
Abbreviation The Abbreviation Element screen appears so you can enter the abbreviation’s definition
Insert new
layer
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Acronym

Citation

Description
in the Title field and define formatting for the tooltip. The HTML editor adds an <abbr>
tag around the selected word. When viewed in a browser, the abbreviation is
underlined and a tooltip appears when you place your cursor over the underlined word.
Screen readers read the abbreviation as a word, rather than spell out the letters.
To add a tooltip that defines an acronym, select the word and click Acronym. The
Acronym Element screen appears so you can enter the acronym’s definition in the Title
field and define formatting for the tooltip. The HTML editor adds an <acronym> tag
around the selected word. When viewed in a browser, the acronym is underlined and a
tooltip appears when you place your cursor over the underlined word. Screen readers
read the acronym as a word, rather than spell out the letters.
To add an in-line citation or reference to another source, select the word or phrase and
click Citation. The Citation Element screen appears so you can enter text in the Title
field for the citation’s tooltip (such as the author, book title, and page number(s) or a
link to a website) and define formatting for the tooltip. The HTML editor adds a <cite>
tag around the selected word or phrase. When viewed in a browser, the citation is
usually italicized and the tooltip appears when you place your cursor over the italicized
word or phrase.

Bold

To make text bold, click Bold. The HTML editor adds a <strong> tag around the text.

Italic

To italicize text, click Italic. The HTML editor adds an <em> tag around the text.

Underline

To underline text, click Underline. The HTML editor adds a <u> tag around the text.

Strikethrough To strike a line through text, click Strikethrough text. The HTML editor adds a <strike>
text
tag around the text.
strike a line through text, click Strikethrough text. The HTML editor adds a <strike>
Superscript To
tag around the text.
To strike a line through text, click Strikethrough text. The HTML editor adds a <strike>
Subscript
tag around the text.
To align text to the left, click Align left. The HTML editor adds an attribute of align=left
Align left
to the division.
align text to the center, click Align center. The HTML editor adds an attribute of
Align center To
align=center to the division.
To align text to the right, click Align right. The HTML editor adds an attribute of
Align right
align=right to the division.
To fully justify text, click Align full. The HTML editor adds an attribute of align=justify to
Align full
the division.
Remove
To remove formatting from text, click Remove format. The HTML editor removes any
format
special format attributes, and the text appears as plain text.
To change the color of text, click Text color and select a color from the palette. The
Text color
HTML editor adds a <span> tag with the color around the text.
To highlight text, click Highlight and select a color for the highlight from the palette. The
Highlight
HTML editor adds a <span> tag with the background color around the text.
Insert
To insert a numbered list, click Insert numbered list. The HTML editor adds an <ol> tag
numbered
at the selected location. The items are numbered sequentially, starting with “1.” To end
list
a list, click Insert numbered list again.
Insert
To insert a bulleted list, click Insert unordered list. The HTML editor adds an <ul> tag at
unordered
the selected location. The items in the list have bullets. To end a list, click Insert
list
unordered list again.
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Description

To increase an indent, click Indent text. The HTML editor adds a <blockquote> tag
around the paragraph. If you increase the indent for a list item, the number or bullet
changes to indicate a secondary relationship to the list.
To decrease an indent, click Outdent text. The HTML editor removes the <blockquote>
around the paragraph. If you decrease the indent of a list item, the text becomes
Outdent text tag
plain text. If you decrease the indent of a secondary list item, the number or bullet
becomes part of the parent list.
To render content on a page, the program uses the stylesheet associated with the
page’s layout. To view your content with stylesheets applied and edit the content for a
Stylesheet
specific stylesheet, click Stylesheet options. On the Stylesheet Options screen, you can
options
select the stylesheet to view and override the background and foreground colors of the
HTML editor to improve readability. For more information about how to view content
with stylesheets applied, see Style Sheet Options on page 33.
To add conditional content to an email message to customize the message for different
types of recipients, click Insert conditional content. On the Conditional Content screen,
you can create the first conditional content block. You can then define the content and
Insert
select the group of recipients who view it.
conditional This button appears only on the add/edit screens for templates, messages, and
content
newsletters.
If you send an email message from Blackbaud Direct Marketing, this option does not
appear.
To verify that conditional content appears as expected for each group of recipients, click
View conditional content. The View Message screen appears.
View
button appears only on the add/edit screens for templates, messages, and
conditional This
newsletters.
content
If you send an email message from Blackbaud Direct Marketing, this option does not
appear.
Insert merge To add merge fields with personalized information to the HTML content, click Insert
fields
merge fields. For more information, see Merge Fields on page 32.
On the add or edit layout screen, you can click Insert content placeholder to add panes
Insert
for parts to the layout. A yellow icon appears as a placeholder for a pane. When you
content
templates and web pages, a pane contains multiple parts. You select the parts to
placeholder create
appear in the pane.
Indent text

Menus on the Toolbar
Menu

Menu name

Description

Font menu

This menu lists common fonts that appear correctly on most web
browsers. To change the font applied to text, select a font.
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Menu

Menu name

Description

Size menu

To change the size of text, select a size from this menu.

apply a paragraph tag to text, select a format from this menu.
Paragraph menu To
For example, select “Normal” for body text.

Merge Fields
To create personalized content, use merge fields to display offline information. For example, in an email, you can
insert the First name merge field so it displays “Hello, <First name>” to the recipient.
• To add merge fields, click Merge fields on the Insert tab in the HTML editor toolbar. The merge fields list
appears in a separate window that you can move around.
• To view the available fields, click the plus sign next to a group of fields to expand the list.
• You can double-click or drag and drop merge fields from the window to the content area.
• You can add multiple fields at a time. To do this, place your cursor to the left or right of the group name or
fields (not over the group or fields) and click and drag your mouse to select them. After the fields are selected,
you can drag them as a group to the content area.
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Style Sheet Options
On your website, the program uses the style sheet associated with a web page’s layout to render the content
you enter in the HTML editor. Because the part on which you enter the HTML content may be shared across
multiple web pages with different style sheets, you may need to edit the content as necessary to improve its
readability with a specific style sheet. When you use the HTML editor in the normal view, you can view the
content as it appears with different style sheets applied.
} View HTML content with a specific style sheet applied
1. On the View tab in the HTML editor toolbar for formatted text and images parts, click Style sheet
options. The Style sheet Options screen appears.

2. In the Edit using style sheet field, select the style sheet to apply to the content in the HTML editor.
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3. Depending on the style sheet, the background and foreground colors of the HTML editor may affect the
readability of your text. Change the background and foreground colors of the HTML editor as necessary
to edit the content.
a. Select Override style sheet colors.
b. Select the color to adjust. For the background color, click Select next to Editor background color.
For the foreground color, click Select next to Editor default font color.
The Select a color screen appears. Using the tabs, you can pick a color three different ways or enter
its hexadecimal value in the Color field.

c. Click Apply. You return to the Style sheet Options screen.
4. Click OK. You return to the HTML editor. The content appears with the selected style sheet and colors
applied.

HTML Editor Table and Line Properties
In the normal view, you can use the HTML editor to design tables, table rows, table cells, and horizontal lines that
divide the web page. You can also adjust the properties for these items to determine characteristics such as size,
styles, and color.
• To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table Screen
appears. On the General and Advanced tabs, you can design the table and adjust its properties. We
recommend only users familiar with HTML and CSS style elements adjust the properties on the Advanced tab.
For more information, see Insert/Edit Table Screen on page 35 Insert/Edit Table Screen on page 35.
• To edit the properties of a row in a table, select the row and click Row properties on the Table tab in the
toolbar. The Table Row Properties screen appears. On the General and Advanced tabs, you can design the row
and adjust its properties. We recommend only users familiar with HTML and CSS style elements adjust the
properties on these tabs. For more information, see Table Row Properties Screen on page 36.
• To edit the properties of a cell in a table, select the cell and click Cell properties on the Table tab in the toolbar.
The Table Cell Properties screen appears. On the General and Advanced tabs, you can design the cell and
adjust its properties. We recommend only users familiar with HTML and CSS style elements adjust the
properties on these tabs. For more information, see Table Cell Properties Screen on page 38.
• To insert a horizontal line, click Horizontal ruler on the Insert tab in the toolbar. On the screen that appears,
enter the width and height for the line and select whether to include a shadow.
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Insert/Edit Table Screen
To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table Screen appears.
On the General and Advanced tabs, you can design the table and adjust its properties. We recommend only
users familiar with HTML and CSS style elements adjust the properties on the Advanced tab. After you create a
table, you can select the table and click Table to edit its properties.
General Tab

Screen Item

Description

Cols

Enter the number of columns.
Enter the amount of space to appear between the ruled line and the content of a cell in
the table.
Select the horizontal alignment of the table. You can select Left, Center, Right, or Not Set.
Enter the pixel dimensions to use for the cells.
Select the CSS class to apply.
Select this checkbox to display a caption at the top of the table. To remove the table
caption, clear the checkbox or delete its code in HTML mode.
Enter the number of rows.
Enter the amount of space to appear between cells of the table.
Enter the width, in pixels, of a border around the table. To display the table with no
border, enter “0.”
Enter the pixel dimensions to use for the cell.

Cellpadding
Alignment
Width
Class
Table caption
Rows
Cellspacing
Border
Height
Advanced Tab
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Screen Item

Description

ID
Summary
Style

Enter a unique identifier for the table.
Enter a summary of the table, such as for speech-synthesizing or non-visual browsers.
Enter the CSS class to apply to the table.
Enter the language code for text in the table, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted cultural
practice for the specified language, such as applying correct punctuation and assisting
screen readers and search engines.
To insert an image that appears as the background of the table or cell, click Browse to
open the Image library and select an image.
Select this checkbox to display a caption at the top of the table To remove the table
caption, clear the checkbox or delete its code in HTML mode.
Select which ruled lines appear between cells of the table. You can select to display all
lines, no lines, or only those between rows, columns, or groups.
Select the directionality for text in the table — left to right or right to left.
Enter the color for the border of the table. You can enter the standard color name or
hexadecimal value, or click Browse to select the color from the palette.
Enter the color for the background of the table. You can enter the standard color name
or hexadecimal value, or click Browse to select the color from the palette.

Language code
Background image
Frame
Rules
Language direction
Border color
Background color

Table Row Properties Screen
To change the properties of rows in the table, select a row and click Row properties on the Table tab in the HTML
editor toolbar. The Table Row Properties screen appears. We recommend only users familiar with HTML and CSS
style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which rows to update with changes — the current row, odd
rows in the table, even rows in the table, or all rows in the table.
General Tab
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Screen Item

Description

Row type

Select Header, Body, or Footer for the row type.
Select the horizontal alignment of the row. You can select Left, Center, Right, or Not
Set.
Select the vertical alignment of the row. You can select Top, Center, Bottom, or Not
Set.
Select the CSS class to apply to the row.
Enter the pixel dimensions to use for the row height.

Alignment
Vertical alignment
Class
Height
Advanced Tab

Screen Item

Description

ID

Enter a unique identifier for the row.
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Screen Item

Description

Style
Language direction

Enter the CSS class to apply to the row.
Select the directionality for text in the row — left to right or right to left.
Enter the language code for text in the row, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.
To insert an image that appears as the background of the row, click Browse to open
the Image library and select an image.
Enter the color for the background of the row. You can enter the standard color name
or hexadecimal value, or click Browse to select the color from the palette.

Language code
Background image
Background color

Table Cell Properties Screen
To change the properties of cells in the table, select a cell and click Cell properties on the Table tab in the HTML
editor toolbar. The Table cell properties screen appears. We recommend only users familiar with HTML and CSS
style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which cells to update with changes — the current cell, all cells in
the row, all cells in the column, or all cells in the table.
General Tab

Screen Item

Description

Alignment

Select the horizontal alignment of the cells You can select Left, Center, Right, or Not
Set.
Select the vertical alignment of the cells You can select Top, Center, or Bottom.
Enter the pixel dimensions to use for the cell width.
Select the CSS class to apply to the cell.
Select whether the cell is a header for a column or includes data.
Select whether the cell type applies to the column, row, group of columns, or group
of rows.
Enter the pixel dimensions to use for the cell height.

Vertical alignment
Width
Class
Cell type
Scope
Height
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Advanced Tab

Screen Item

Description

ID
Style
Language direction

Enter a unique identifier for the cell.
Enter the CSS class to apply to the cell.
Select the directionality for text in the cell — left to right or right to left.
Enter the language code for text in the cell, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.
To insert an image that appears as the background of the cell, click Browse to open the
Image library and select an image.
Enter the color for the border of the cell. You can enter the standard color name or
hexadecimal value, or click Browse to select the color from the palette.
Enter the color for the background of the cell. You can enter the standard color name or
hexadecimal value, or click Browse to select the color from the palette.

Language code
Background image
Border color
Background color
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Before you can manage communication information, we recommend you set up configuration options. From
Marketing and Communications, you can access these options under Configuration.
You use configuration options to set up Marketing and Communications for your users. Use these options to
manage the various elements necessary to communicate with your constituents to support your fundraising
efforts.

Ask Ladders
An ask ladder is a set of fixed or calculated ask amounts based on a constituent’s giving history and included on a
response device. You assign ask ladders to segments in a marketing effort to ensure each recipient receives the
appropriate ask amount on their marketing effort. On the Ask Ladders page, you can manage the ask ladders
your organization uses. To access this page from Marketing and Communications, click Ask ladders under
Configuration.
Under Ask Ladders, you can view the name, entry amount, and record source of each ask ladder. You can also
view whether an ask ladder is active or in use. To include only ask ladders with a specific status in the grid, click
Filter, select whether to view inactive or active ask ladders, and click Apply. To update the information in the
grid, click Refresh List.
From the grid, you can also manage the ask ladders your organization uses.

Add Ask Ladders
When you create an ask ladder, you define the calculations for ask amounts based on an “entry amount” value
from the constituent’s giving history, such as the most recent or largest gift amount. The parameters you define
for an ask ladder determine the lower and upper limits of an entry amount range and the ask amount
calculations that apply to constituents who fall within that range. To calculate ask amounts, the program adds a
specified amount to the entry amount or multiplies the entry amount by a specified value. For fixed ask ladders,
you define ask amounts used for all constituents. This table demonstrates each type of ask ladder (Add, Multiply,
and Fixed) and how ask amounts are calculated for each type.
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Amounts at or above

Type

Ask
1

Ask 2

Ask 3

Round
up to

Ask Ladder

0
(Entry amount range =
$0 - 24.99)

Fixed

25

50

75

1

$25, $50, $75
Applies to all entry amounts less
than $25

25
(Entry amount range =
$25 - 49.99)

Add

25

35

45

5

$25 (+25, +35, +45) = $50, $60,
$70
$30 (+25, +35, +45) = $55, $65,
$75
$35 (+25, +35, +45) = $60, $70,
$80
$40 (+25, +35, +45) = $65, $75,
$85
$45 (+25, +35, +45) = $70, $80,
$90

50
(Entry amount range =
$50+)

Multiply

1.5

2

2.5

10

(50*1.5, 50*2, 50*2.5) = $75,
$100, $125
(60*1.5, 60*2, 60*2.5) = $90,
$120, $150
(70*1.5, 70*2, 70*2.5) = $105,
$140, $175
Etc.

} Add an ask ladder
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Click Add. The Add ask ladder screen appears**.
3. On the Ask Ladder tab, enter a unique name to help identify the ask ladder.
4. If you have multiple record sources defined, the Record source field appears. Select the record source to
use for this ask ladder.
5. To restrict use of the ask ladder to only specific site at your organization, in the Site field, select the site to
use the ask ladder. An ask ladder can be used with only marketing efforts assigned to the same site.
6. In the Entry amount field, select the type of entry amount to use for this ask ladder. The values available
for this field are any smart field or dollar amount fields associated with the record source, such as Last
Gift, Largest Gift, or Average Gift. To create an ask ladder with fixed values, select “<none>.”
For information about smart field ask ladder values, see Smart Fields for Ask Ladders on page 6.
7. Under Definition, enter the parameters for ask ladder calculations. Each row defines the lower and upper
limits of an entry amount range and the ask amount calculations that apply to constituents who fall
within that range.
a. In the Amounts at or above column, enter a value for the lower limit of an entry amount range. For
example, if you enter 0, 25, 50, 75, and 100 in the Amounts at over above column, the entry
amount ranges for the ask ladder are:
$0 - 24.99
$25 - 49.99
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$50 - 74.99
$75 - 99.99
$100+
Note: To ensure that each constituent receives an ask ladder, we recommend that you use $0 as the first value
in the Amounts at or above column. If you do not have a constituent’s giving history, such as if the constituent
comes from an acquisition list or has a constituency of Relation only, his entry amount is considered $0.
b. In the Type column, select the method to calculate ask amounts.
“Add” — Select this option to add the values entered in the Ask columns to entry amounts.
“Multiply” — Select this option to multiply the entry amount by the amounts entered in the Ask
columns.
“Fixed” — Select this option to use the values entered in the Ask columns for all constituents in this
entry amount range. Fixed ask ladders are useful for constituents who do not have an entry amount
defined.
c. In the Ask columns, enter values according to the calculation method selected in the Type field.
If you select Add, enter the values to add to the entry amount, such as 50, 75, and 100. For a
constituent with an entry amount of $30, the ask ladder included on the marketing effort would be
$80, $105, $130 (if rounded to 1 or 5).
If you select Multiply, enter the values to multiply by the entry amount, such as 1.5, 2, and 2.5. For a
constituent with an entry amount of $30, the ask ladder included on the marketing effort would be
$45, $60, $75 (if rounded to 1 or 5).
If you selected Fixed, enter the fixed values to use for the entry amount range, such as 50, 75, 100.
For all constituents in the entry amount range, the ask ladder included on the marketing effort
would be $50, $75, and $100.
d. In the Prompt field, enter the text to appear on the marketing effort for write-in ask amounts, such
as “Other Amount.”
e. In the Round up to field, enter a whole number to round up calculated ask amounts. For example, if
you enter 10, the program rounds all calculated ask amounts up to the tens place value.
Note: If you select <none> in the Entry amount field, you can define only one row in the grid because that ask
ladder is used for all constituents included in the marketing effort.
8. To test the parameters of calculated ask amounts, select the Preview tab.
a. In the Entry amount range field, select an entry amount range based on the values entered in the
Amounts at or above column. The grid displays the calculated ask amounts for all entry amounts
included in the range.
b. In the Interval field, select the place value to round to. This changes the ask amounts in the grid
based on rounding.
9. To adjust the ask amounts as necessary, select the Ask Ladder tab.
10. Click Save. You return to the Ask Ladders page.

Edit an Ask Ladder
You can edit ask ladders that are not in use on an activated marketing effort.
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} Edit an ask ladder
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Select an ask ladder and click Edit. The Edit ask ladder screen appears.
3. Make changes as necessary. The items on this screen are the same as on the Add ask ladder screen. For a
detailed explanation of the options, see Add Ask Ladders on page 1.
4. Click Save. You return to the Ask Ladders page.

Delete an Ask Ladder
You can delete ask ladders that are not in use on an activated marketing effort.
} Delete an ask ladder
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Under Ask Ladders, select an ask ladder and click Delete. A confirmation message appears.
3. Click Yes. You return to the Ask Ladders page.

Copy an Ask Ladder
To create a new ask ladder with similar settings as an existing ask ladder, you can copy the existing ask ladder
rather than create the new ask ladder.
} Copy an ask ladder
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Under Ask Ladders, select an ask ladder and click Copy. A confirmation message appears.
3. Click Yes. You return to the Ask Ladders page. Under Ask Ladders, the new ask ladder appears with the
name “Copy of <ask ladder>.”
4. Edit the new ask ladder as necessary. For information about how to edit an ask ladder, see Edit an Ask
Ladder on page 3.

Mark an Ask Ladder Inactive or Active
Rather than delete an ask ladder that you no longer use, you can mark it inactive. Inactive ask ladders remain in
the database but are not available when users select ask ladders for a segment.
After you mark an ask ladder inactive, you can mark it active to resume its use.
} Mark an ask ladder inactive
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Under Ask Ladders, select an ask ladder and click Mark inactive. A confirmation message appears.
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3. Click Yes. You return to the Ask Ladders page.
} Mark an ask ladder active
1. From Marketing and Communications, click Ask ladders under Configuration. The Ask Ladders page
appears.
2. Under Ask Ladders, select an inactive ask ladder and click Mark active. A confirmation message appears.
3. Click Yes. You return to the Ask Ladders page.

Add Ask Ladder Overrides for an Unactivated Marketing Effort
You can create ask ladder overrides to apply different ask ladders to selections rather than the one specified for
their segment.
} Add an ask ladder override
1. From the record of an unactivated marketing effort, click Edit ask ladder overrides under Tasks. The Edit
ask ladder overrides screen appears.
2. Click Add an ask ladder override. The Add ask ladder override screen appears.
3. In the Selection field, select the selection the override applies to.
4. In the Ask ladder field, select the ask ladder to apply to the selection.
5. Click Save. You return to the Edit ask ladder overrides screen. In the grid, the new override appears.
6. Click Save. You return to the marketing effort record.

Edit an Ask Ladder Override
You can edit ask ladders overrides that are not in use on an activated marketing effort.
} Edit an ask ladder override
1. From the record of an unactivated marketing effort, click Edit ask ladder overrides under Tasks. The Edit
ask ladder overrides screen appears.
2. In the grid, select an ask ladder override and click Edit an ask ladder override. The Edit ask ladder
override screen appears.
3. Edit the selection or ask ladder as necessary.
4. Click Save. You return to the Edit ask ladder overrides screen.
5. Click Save. You return to the marketing effort record.

Delete an Ask Ladder Override
You can delete ask ladder overrides that are not in use on an activated marketing effort.
} Delete an ask letter override
1. From the record of an unactivated marketing effort, click Edit ask ladder overrides under Tasks. The Edit
ask ladder overrides screen appears.
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2. In the grid, select an ask ladder override and click Remove an ask ladder override. A confirmation
message appears.
3. Click Yes. You return to the marketing effort record.

Smart Fields for Ask Ladders
The smart field for the ask ladder value calculates values for ask ladder entry amounts based on criteria you set.
The calculation considers only revenue that falls within the date and amount parameters you set on the
Parameters tab of the Add ask ladder smart field screen.
The table below explains each field on the Parameters tab:
Screen Item

Description

Value to return

Select “Largest gift amount,” “Smallest gift amount,” “Last gift amount” (the most
recent gift), or “Average gift amount.”
Enter the entry amount to use when a value can not be calculated.
Select “All revenue,” “This calendar year,” “Past {n} months.” or “Specific range.” If
you select “Past {n} months,” enter the number of months. If you select “Specific
range,” enter a starting and ending date.
Select “All revenue” or “Specific range.” If you select “Specific range,” enter a dollar
amount range in the fields.
Select a revenue selection from Query. Use this field for more specific filtering; for
example, finding revenue based on gift type.

Default value
Revenue date options
Revenue amount
options
Selected revenue

Finder Number Settings
A finder number is a sequential number assigned to each name on a recipient list. and printed on each reply
form. To speed the data entry of responses to an appeal, finder numbers eliminate the need to enter a name and
address. Finder numbers generally consist of 15 or fewer characters, less than a name and address and therefore
less time-consuming to enter.
Finder numbers are used to match a gift to a particular marketing effort, to enable tracking and reporting on
marketing effort performance. Activating a marketing effort generates the finder numbers. In a marketing effort
export, you can include Finder number as one of your export fields.
You can specify the next finder number to use when you activate a marketing effort and the number of
characters available in your numbers.
} Set finder numbers
1. From Marketing and Communications, click Finder number settings under Configuration. The Finder
number settings screen appears.
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2. In the Next finder number field, enter the next finder number for the program to generate.
3. In the Fixed width field, enter the number of characters for your finder numbers. The default width of 8
characters allows for 99,999,999 finder numbers before the program needs to reuse a finder number. The
largest width allowed is 17 characters. You can increase this setting, but not decrease it below the width
of the highest assigned or reserved finder number.
4. To use the Mod 10 algorithm to validate finder numbers, select Check digit. The algorithm detects singledigit errors as well as transpositions of adjacent digits. A single digit is appended to each finder number
to generate the validation calculation. For information about how the program calculates the check digit,
see Calculate Check Digits on page 7.
If you select to use a check digit with your finder numbers, you cannot clear it in the future. Also, the
check digit functionality applies to only the number in the Next finder number field and any number
that occurs afterward, not finder numbers already in use.
In the Sample number field, a preview of your numbers based on your settings appears.
5. Click Save. You return to Marketing and Communications.

Calculate Check Digits
If you select to use a check digit with your finder numbers, the program uses the Luhn, or mod 10, algorithm to
validate finder numbers. The algorithm detects single-digit errors as well as transpositions of adjacent digits. To
generate the validation calculation, the program appends a single digit to each finder number.
To calculate a check digit, the program uses this algorithm:
1. The program starts with the last digit in the finder number and, as it moves to the left, doubles the value
of every other digit. For example, to calculate the check digit for finder number 56789:

9

9 * 2 = 18

18

7 * 2 = 14

14

5 * 2 = 10

10

8
7
6
5

8 CHAPTER 1
2. The program adds the individual digits of the doubled numbers to the undoubled numbers from the
original finder number.

9

9 * 2 = 18

18

1+8=9

8
7

8
7 * 2 = 14

14

1+4=5

6
5

9

5
6

5 * 2 = 10

10

1+0=1

1
9 + 8 + 5 + 6 + 1 = 29

Note: The modulo operation finds the remainder when you divide a number. X modulo Z (abbreviated as X
mod Z) is the remainder when you divide X by Z. For example, “7 mod 3” equals 1, while “9 mod 3” equals 0.
3. The program calculates the sum of the digits mod 10. For this example, 29 mod 10 = 9. (29 divided by 10 =
2 with a remainder of 9.)
4. For the check digit calculation, the program subtracts the remainder from 10. So, 10 - 9 = 1. The check
digit equals 1.
If the check digit equals 0, the finder number is valid. In this example, because the check digit equals 1, the 56789
finder number is invalid.

Blackbaud Internet Solutions Integration
When Blackbaud Direct Marketing integrates with Blackbaud Internet Solutions, you can send email messages
targeted to segments in a marketing effort. Emails are merged with data from Blackbaud Direct Marketing to
personalize the content of each message. After the emails are sent, you can track their effectiveness using
reports and KPIs.
Before you send emails from Blackbaud Direct Marketing, the system administrator must configure the
integration with Blackbaud Internet Solutions so the two programs can share information.
After the integration package is loaded, the Website integration link appears under Configuration on the
Marketing and Communications page. Click this link to access the Website Integration page.
For more information about how to configure integration with Blackbaud Internet Solutions, see the Blackbaud
Direct Marketing Blackbaud Internet Solutions Integration Guide.
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